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Incident 
number 

Defect 
number Description 

9288 18276 CLIST now ordered correctly 

9279 18411 Cableway Branch table form - changed TAB order of Textboxes 

9446 18414 RATTA position affected by Fillet Radius on neighbouring POINTRs 

9377 18420 Unable to create Bolt Specs using the UI 

9284 18427 
Cable reconnected between start equipment and head / between end equipment and tail 
changed, after the equipment is moved 

9752 18850 
Inserting a route point on cableway using model editor now updates affected RNODEs 
(changing ZDIS and leaving PKDIS unaltered) consistent with model editor. 

9619 18890 Equipment Import errors and hangs after selecting the CSV file to import 

6769 19190 Merge changes fails with  dbnames over 49 characters 

10869 20226 
HVAC Assemblies - when placing assembly in model, application returns to Monitor, if the 
user selects the assembly component displayed in the 3d assembly view. 

25.4.1 Fixes to Global Daemon 
 

User incident Defect Details 

HPD 34926 
HPD 36158 
HPD 36489 

P-10101  
P-10184  
P-11399  

Corrected a problem causing Global to freeze PDMS during updates 

HPD 38428 P-10421 Prevent crash for 100+ Inter-db macros 

HPD 29322 P-9535;     P-
9439 

Missing file no longer stalls Change primary;  command now fails if DB File is missing 

 P-14520 Recover command stalls when recovering to an Offline location 

 P-14829 Daemon crashes when Global DB is not available during a Synchronise command 

 P-8855 Unable to create extract at Satellite locations due to timing issues on the Global 
Database 

 P-14971 Propagation of Databases leads to Dabacon Error 578 on secondary databases 

HPD 37489 P-10281 
P-7465 

Spurious “Dabacon 10 – Invalid reference” errors in Daemon  

25.4.2 Fixes to PDMS Global Admin 
 

User incident Defect Details 

HPD 33573 P-11576 Reverse Propagation after Generate; removed automatic Expunge except for new 
system db 

HPD 38385 P-11575 CHANGE ACCESS crash (Deleted user) – relates to ADMINISTER command 

HPD 26298 P-9274 Replicate System Satellite errors 

 P-14828 Crash on MAKE GLOBAL when no TRANSACTION DB exists 

 P-14836 Crash on EXTRACT FLUSH when daemon is down 

 P-16553 Implicit Global claim leads to crash on heavily loaded machines 

SI-8136 P-16817 Admin Elements Form (Databases) Sort By Location is not correct for Satellites 

SI-8163 P-16669 It is not possible to Filter on Location for a number of Admin forms: 

 Create MDB 

 Database Allocation (By Location) 

 Database Integrity Check 

25.4.3 Fixes to PDMS Global Admin – Offline Locations 
 

User incident Defect Details 

HPD 37152 P-6578 Unable to transfer Global Database 
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HPD 37069 P-6583 Transfer of inter-DB macros with NULL references causes the Offline Transfer process 
to crash 

 P-7420 Ensure that the system databases are copied correctly during Transfer process 

 DFN 1486 Option to propagate non-propagating databases during Transfer process 

 P-15524 “Database not open error (1,267)” reported on TRANSFER FROM command 

25.5 Corrections & minor enhancements *12.0.SP5* 

Corrections made to SP5 include the following: 

Incident 

number 

Defect 

number 

Description 

SI-9172 P-18130 Integrator: Not able to set link on nozzles below subequipment 

SI-14970 P-23466 Integrator: "Equip Connection" form not working properly - Delete TMPL should clear deslnk 

SI-1838 P-3887 The SAM Project has no Data Set for Schematic 3D Integrator 

SI-7755 P-17839 
Pipe Stress Interface: now works with stress group names containing more than one slash 
(for example : /test/test)  

SI-7032 P-15305 
Pipe Stress Interface: Incorrect size of components in Caesar when PDMS Bore Units set to 
INCH  

SI-18020 P-26305 Paragon: new interface can now create Insulation Specs 

SI-11429 P-20836 Draft: Cannot use PLTs created from DM as backing sheet reference 

SI-13401 P-22599 Draft: A Design UDET (for ZONE) can now be shown 

SI-9985 P-20283 Equipment Associations now working in Imperial Units 

SI-9296 P-18222 Cable: routing now uses MAXFIL attribute 

SI-14607 P-23525 
HVAC user defined fitting creation sets the properties including despar correctly in imperial 
units 

SI-15316 P-23785 Translucency not being read from the toolbar settings 

SI-14804 P-23983 Isodraft entry crashed under some circumstances when using UDAs 

SI-8071 P-16890 The COCO Tables are hard coded.  

SI-8435 P-17052 Paragon: a GUI error causing a message “Array element does not exist” has been corrected. 

SI-8363 P-17418 Export facility to excel file required for Engineering View of Spec 

SI-8300 P-17941 Paragon: Creating spec - LJSE is now available in the Standard Headings 

SI-8360 P-18082 
Paragon: Create parts from template. Part created should take template PRITYPE/SUBTYPE 
and Description. 

SI-9942 P-20463 Spec headings out of step after deleting SPCO's 

SI-8301 P-20464 Paragon: Modify category (boltset) 

SI-11225 P-20465 Paragon: Error when headings in form don't match attributes of data element 

SI-12953 P-21974 Paragon: Performance issue when selecting Detail Text from the UI 

SI-12960 P-21984 
Paragon: The Equivalent Lengths in the Bolt Length table now accept input and display 
output to 3dp. 

SI-13528 P-22333 Paragon: creating new scom 

SI-9586 P-18648 Structural: Create Hole utility now works properly in inches 

SI-7976 P-17379 Structural modelling 3D constructs 

SI-6044 P-18891 Delete option on the Right-Click Design Explorer menu does not check Lock status 

SI-11324 P-20549 
Corrected a memory leak associated with the repeated creation and deletion of PML 
objects. This could cause a process termination due to the program’s size.  

SI-14427 P-23004 Group form is not populated following MDB UP  

SI-14140 P-23038 
Draft: a TEXP using True Type Fonts can now have an ‘&’ as the first character of lines after 
the first!  

SI-13936 
P-19248 
P-23246 

Design: the Graphics in a Local View no longer disappear when the view is floated 
 

SI-15062 P-23735 PMLDEFINITION function returns invalid paths 

SI-11041 P-20348 Error with protected db - appware requires read-protected attribute values 
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Incident 

number 

Defect 

number 

Description 

SI-14378 P-23079 Getting user list in ADMIN with function 'User process...' is sometimes not worked. 

SI-11777 P-23082 Members List doesn´t show all branch members like in PDMS 11.6 

SI-13935 P-24254 Members List behaviour changed from 11.6 to 12.0 

SI-13923 P-24597 
Paragon: Re-ordering or removing databases from the MDB did not work after running an 
Excel Import – gave Error 'Database Not Part of MDB'  

SI-5580 P-12923 
When Draft DB is made in Admin, must have attribute such as in case it is made in Draft 
Module 

SI-8736 P-17451 Draft: Hatching pattern OFF does not work 

SI-12988 P-21794 Equipment penetrations require the extrusion to intersect the penetrated item. 

SI-15387 P-24069 Equipment: Position section of Modify Attributes form does not work correctly for primitives 

SI-8070 P-16746 
Cable: Incorrect message 'Valve does not have a description attribute' when creating a cable 
from a piece of equipment to a motorised valve. 

SI-12089 P-22860 Model Editor Fine Linear Increment Move does not work in Imperial Units 

SI-6849 P-14678 ASL: Stair Flights – Stringer representation L-shape stairs. 

SI-10165 P-19787 ASL: Excluded assemblies in Settings are still available on Create forms 

SI-13881 P-22705 ASL: Platforms – Mass Properties have been corrected 

SI-15873 P-24224 Structural: can now use feet for fillet radius; imperial default  also corrected 

SI-15856 P-24834 Pipe connection display  gets the wrong nozzle sequence if it’s not named 

SI-4006 P-18266 Paragon: DATA/TEXT element creation is out of step on Modify>Category 

SI-9713 P-18812 Paragon: GUI no longer has "Add Identified" items to create list 

SI-11341 P-22819 
Paragon: GUI now better at handling the creation & deletion of TEXT & DATA elements 
associated with parameters 

SI-8963 P-17863 Design: SAVE VIEW 4 now works 

SI-9768 P-19295 Spooler: cannot Drag and Drop from Fabrication Explorer to Graphical Display 

SI-4181 P-19211 Admin: Fails on Working Extracts with dots in User Names 

SI-5175 P-16497 Draft: Cannot click on match-lines  

SI-11745 P-20839 ADP Error for Centre Line Utility 

SI-17129 P-25256 Equipment: report column syntax 

SI-614 P-8527 HVAC: model editor improved 

SI-12405 P-22615 ASL: Platforms - Platform/Opening Geometry 

SI-12314 P-22621 ASL: Platforms - Selecting frame profiles 

SI-9964 P-23594 
Changing SCTN default SPREF with (Create) Section form open does not allow further EDG 
picks. 

SI-8296 P-16881 Router Crashes if you delete the Routing Rule and Rerun the Pipe Route 

SI-1885 P-19403 Admin Elements form can be set to display Username or Password 

SI-14326 P-22915 Unhandled Exceptions in PID Manager  with Windows user access rights 

SI-6928 P-14912 The cable shall be routed from a route point to another route point by defining PRPS 

SI-9752 P-18850 Cable:  inserting route points using model editor now works correctly 

SI-7937 P-16550 Pipe Piece Cutting is not Correct 

SI-8129 P-16625 Pipe Modelling - Autoname Crash 

SI-9943 P-20221 Production Checks' produces incorrect spool  

SI-8067 P-17004 Auto naming - cable for catalogue 

SI-9519 P-20242 
If we use the ‘underbar’ for SCOM and displayed it in ModelView, Command Window display 
some errors. 

SI-9643 P-18781 Modify > Equipment Specification Error - Wrong EQUI Modified 

SI-2613 P-4910 AutoClash does not work properly. Need to deactivate Model editor to see clash 

SI-4076 P-7663 Paragon: two NSEX appear in graphics when making NSEX under solid primitive 

SI-2747 P-14646 
Design: 3D view settings such as transparency did not work correctly after setting the LEVEL 
of primitives in an obstruction volume. 

SI-7036 P-17708 General: excessive decimal places displayed (in previous versions of PDMS 12).  

SI-10058 P-19278 Items selected using BOX selection are not included in the Drawlist as REME 

SI-4739 P-17758 Equipment Representation Form – Apply Button needed to be clicked twice! 

SI-5586 P-21648 Equipment Association Organisation 
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Incident 

number 

Defect 

number 

Description 

SI-6891 P-15269 
Cable: when reconnect two branches, the connection status of the main and side branches is 
now handled more consistently 

SI-8627 P-19499 Cable: Excess length was not correctly included in the total after Modify Cable  

SI-13586 P-22752 Cable Tray creation error 

SI-12011 P-23728 Cable: Model Editor - moving a component into another leg of the branch 

SI-4355 P-10491 HVAC - Fit Function Error 

SI-8874 P-17866 HVAC: Error Inserting User Defined Fittings 

SI-9588 P-21676 Clash Detection - AREADE Obstruction Level Incorrect 

SI-10167 P-23521 Isodraft: Option file directory does not change between Company and Project 

SI-11883 P-23666 Model Editor didn't work between connected two components 

SI-9457 P-18621 Primitive Creation Lock/Align with PPoint Error 

SI-9594 P-18846 Mass Properties Forms Error 

SI-10272 P-20925 Hole Management Catalogue Error 

SI-8826 P-25495 Error in default values of Hole Definition window 

SI-10056 P-19349 
Equipment: Aids shown by Position > Relatively were always shown as E, N, U – they did not 
allow for the co-ordinate format set by the user 

SI-3956 P-23089 Admin: Expunge User Process form 

SI-9938 P-19285 Draft: zoom by fencing if background colour is white 

SI-9941 P-19287 Draft: label intelligent text  

SI-12223 P-21314 Draft: Edit > Move Primitive/Node To > E,N,U 

SI-12217 P-21315 Draft: Construct > Repeat >Offset - Number of Copies Error 

SI-12224 P-21316 Error when selecting a Nozzle to move Primitive 

SI-8629 P-17377 More than one cable can be connected to each Equipment electrical connection 

SI-7921 P-16385 HVAC Rectangular Tee Orientation Problem. 

SI-9450 P-22043 Radial Grid Angle Defect 

SI-13847 P-22810 Panel Fittings - Error when Picking Fitting Position 

SI-8404 P-20955 Structural Modelling - Negative Extrusion Axes 

SI-14432 P-23052 Equipment: Rotate option on Primitives form - Local Axes 

SI-4341 P-8530 HVAC - Model Editor Error on Bends 

SI-7137 P-14919 Graphics view not updated in PDMS11.6 after using Nuclear Room Manager 

SI-7138 P-14917 Nuclear Concrete: Confirmation of undo 

SI-1815 P-17552 MDS Isometric Late Evaluation of Text not working if you do not load MDS 

SI-4149 P-25452 MDSDFLTS directory has PDMS 11.6 data in it which should be removed. 

SI-5235 P-25531 MDS: Coordinate mode error when create HVAC support 

SI-2484 P-25451 MDS Health Check Fails 

SI-11882 P-25411 MDS: Create>Copy forms did not work when using the "mds.bat" to enter PDMS. 

SI-11718 P-25416 MDS: Modify Hanger - Rod Size Error 

SI-11243 P-25200 Paragon: Active False does not work for MDS Hangers. 

SI-11507 P-25502 Pipe Support  ancillary  /MDS/AN09-6 does not draw correctly 

SI-15107 P-23709 ExPLANT-I: Cylinders unnecessarily exported as capped surfaces 

SI-13778 P-24571 Diagrams: now support the use of Imperial bores 

SI-15343 P-23744 Diagram: In Inch Projects  Branchconnectors (TEE) offleg shows in mm 

SI-10420 P-20315 Diagrams: Schematic Toolbar comes undocked 

SI-11083 P-20779 Diagrams: Rename cable chain option 

SI-11766 P-21158 
Diagrams: the Schematic Explorer now works correctly after splitting a pipeline and joining it 
back together 

SI-13544 P-22637 Cable: Auto routing by define route now works correctly 

SI-5717 P-13286 Global: Improved performance of remote merge 

SI-14918 P-23703 Global crash when claim fails  

 P-22838 Global: Dabacon errors wrongly reported as ‘db in use’ during Update 

SI-10373 
SI-14209 

P-19710 P-
22855 Global Admin: cannot convert string to DBREF error when modifying project Hub 

HPD 40052 P-22858 Global Admin: After making a project Global project, LOCKING can't be reset 
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Incident 

number 

Defect 

number 

Description 

HPD 38641 
SI-5672 

P-10508 P-
12951 Global Admin Elements form problem 

SI-4035 P-7462 Global Admin: Check for Offline location initialised 

 P-21865 Global Admin: Offline transfer of macros made more robust 

SI-10388 P-19725 Global Admin: Check button on the Locations Form did not work 

SI-11012 P-20248 Global Admin: Error on Locations Form 

SI-11074 P-20314 Global Admin: Picture/Neutral Format Files not setting correctly on form 

SI-11075 P-20307 Global Admin: Changing Picture File Propagation flag can cause Reverse Propagation error 

SI-6919 P-14758 Global Admin: UPDATE event causes form error 

SI-4093 P-7695 Global Admin: Extract Create Form Description not set 

The following corrections were made in PDMS 12.0.SP5 fix releases and were also applied to SP6 

12.0.SP4.7: 

Incident 

number 

Defect 

number 

Description 

SI-16151 P-24452 Error message was given when a valve, fitting, etc. was included 

 
12.0.SP4.7 

Incident 

number 

Defect 

number 

Description 

SI-9508 P-24933 
Model editor uses incorrect handle for some components when the pipe route is incomplete 
– 11.6 behaviour has been restored 

SI-7099 P-14939 Diagrams: The valve number wrapping with symbol should be able to be created. 

 
12.0.SP4.6 

Incident 

number 

Defect 

number 

Description 

SI-11081 P-22822 DRAFT: Justification and Alignment have been corrected for standard DXF output 
 

12.0.SP4.5: 

Incident 

number 

Defect 

number 

Description 

SI-15001 P-23540 GUI forms did not work correctly if imperial distances including a foot mark ‘ were entered 

SI-13404 P-24063 
Clash missed in some circumstances for primitive with a minimum dimension greater than 
20 metres 

 P-24187 Diagrams: Refresh doesn't work for referenced attributes. 

SI-14804 P-24191 ISODRAFT entry crashed if an ATTA has more than 100 UDAs 

SI-15863 P-24223 

Database crash under certain specific conditions – initially identified for Global Daemon 
Flush DB 
(see also release 51896 – Global Server 12.0.SP4.5) 

SI-8838 P-24457 Admin: Performance problem merging System and Global databases 

 

12.0.SP4.4: 

Incident 

number 

Defect 

number 

Description 
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 P-14025 Diagrams: Primary-Secondary shape handling dialog should be more easily understood 

 P-21805 Diagrams: The label offset is no longer cleared by Edit Master 

 P-22589 P&ID Manager: Incorrect branch head and tail refs no longer set on import 

SI-14259 
P-22876 

Correction to <project>DFLTS path – caused problem with Global Satellite location creation 
(and possibly similar issues with Replicate function. 

 P-23297 AVEVA PMLFileBrowser now supports UNC file paths 

SI-14890 P-23524 Piping: GUI problems with pipe bores in imperial units 

 P-23579 P&ID Manager: UUNI not set properly in Lexicon 

 P-23580 P&ID Manager: Imperial Distance/Bore units on UDAs were not correctly imported 

 P-23581 P&ID Manager: unqualified values were not correctly interpreted when setting UDAs 

SI-14560 P-23641 GUI problems setting some text attributes that include a foot mark ‘ 

SI-9943 P-23777 ‘Production Checks' now produce correct spool 

SI-15397 P-23798 Draft: Limits defined view not working with Imperial units 

 
12.0.SP4.2: 

Incident 
number 

Defect 
number 

Description 

SI-11830 P-21360 Diagrams: Consistency Check Error for Cable Connection to geometry end 

 P-21669 Diagrams: Highlight / Reset Highlight resets user defined formula for line width (& colour) 

SI-9943 P-20221 Pipe 'Production Checks' produces incorrect spool  

SI-7937 P-16550 Pipe Piece Cutting is not Correct for Branch and Tee Point 

SI-11431 P-22321 Diagrams: Copy - paste to Custom Properties causes crash 

SI-8665 P-20834 
When generating pipe spool, the pipe component connected to TEE becomes a separate 
pipe spool. 

SI-10053 P-20251 Isodraft: sheet continuations shown at coordinates E 0 N 0 EL 0. 

SI-9891  P-20564 Isodraft: Missing label for support plates on isometrics  

SI-12057 P-22310 Isodraft: Parameterized Weights on isometrics incorrect  

SI-11337  P-22320 Isodraft: Wrong Dimensions on iso with Overallskews ON  

HPD 38939 P-22331 

Isodraft: Spool Drawing with several Spools, plotted using ISOTYPE SPOOL and 
SpoolNumbers PREF FROMDB options, means that Spool n does not necessarily correspond 
to the nth Plot File 

SI-3231 P-22839 SPECON OUTPUT command ignores database IPR protection  

 P-22864 Draft: Corrupt Cyrillic DXF output when using TrueType text 

 P-22921 Paragon: Error when modifying specifications (introduced by fix for P-20455) 

SI-6600 P-22941 
It is now possible to replace the default system (software defined) popup menu on the 
command line form using a user defined PML menu. 

SI-13027 P-22253 Integrator: Connections not set on Build SCPLINs connected branch head to tail 

 
12.0.SP4.1: 

Incident 

number 

Defect 

number 

Description 

SI-9284 P-18427  

P-19183 

Cable Design – can now reconnect the head or tail of the cable with any precedence of the 

legs in orthogonal free route (e.g. 'xyz' 'zyx' 'zxy' and so on...). 

 P-21821 DRAFT: Pipe sketches wrong when SITE or ZONE not at Pos (0,0,0) 

 P-21828 DRAFT: PSPOOLs accidentally drawn when PIPEs included in IDList 

SI-10083 P-20455 PARAGON: User interface error with Russian characters:  

 P-21467 PARAGON: If we use the ‘underbar’ for SCOM and display it in ModelView, Command 

Window displays errors. 

SI-11549 P-21622 DIAGRAMS: Unable to reference templates from the Master Project 

SI-13737 P-22448 UDA values were lost after upgrade from PDMS 11.6.if the type of data had been changed 

from an array to a scalar at some point. This unusual situation is now handled correctly.  
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25.6 Corrections & minor enhancements *12.0.SP6* 

The following corrections were made in PDMS 12.0.SP5 fix releases and were also applied to SP6. 

Details of a number of the other corrections to SP6 are given in the release letter. 

12.0.SP5.4: 

Incident 

number 

Defect 

number 

Product Description 

 P-29357 MDS 
Correction to allow use of semi-colon ";" as separator in an EVAR setting 
that uses a SEARCH PATH 

19571 P-28624 PDMS 
Isodraft: UDET handling improved to prevent problems with Explorer 
settings after switching MDB or running an iso 

19350 P-29426  PDMS 
Draft: GENERATE MODEL performance is improved – it now works more like 
DESADD or ADD 

21836 P-29454 PDMS Draft: Improved plotted line thickness 

 P-26887 
Integrator Corrected missing resource string that gave error (195,212) and prevented 

diagram comparison 

22415 P-27028 Integrator Error in report action now gets red icon and treated as an attribute error 

21148 P-28635 
Integrator Two users can now use Build command at the same time: claims CYMLNK 

rather than WORLD  

 P-29126 Integrator Corrected Match of SCFITT(TEE) with flanges 

22342 P-29396 Integrator Performance of colour coding the 3D graphics view improved 

14379 P-26847 Sch. M. M. Log files are now written to a folder below PDMSWK 

 P-27582 Sch. M. M. Segments will no longer be merged from one line into another 

 P-28521 Sch. M. M. 
Valve, actuator and spectacle blind symbols are now shown with correct 
rotation relative to pipeline 

 P-28631 Sch. M. M. 
Schematic valves and instruments are now imported with correct types 
SCVALV and SCINST 

21781 P-28998 Sch. M. M. SVG file is now correctly generated when importing in TTY mode 

 P-29083 Sch. M. M. P&ID is now correctly processed to allow navigation & picking  

 P-29084 Sch. M. M. Default UDAs can be loaded with refs to UDETs and default values 

21155 P-29288  Sch. M. M. Saved searches no longer cause the application to crash 

 P-29376 Sch. M. M. 
Release status now consistent with project settings over repeated update 
imports 

12.0.SP5.3: Release No. 51924 

Incident 

number 

Defect 

number 

Product Description 

 P-26639 PDMS 

The Plot utility no longer registers com at runtime. Under certain 
circumstances, this could cause installation ‘healing’, which failed if the user 
did not have admin rights. 

 P-28720 SQL direct 
Crash when connecting to the PDMS server – please see note below (under 
Exceptions) for a workaround  

17459 P-26507 Diagrams 
System now prompts for leave shape & size when the user drops a shape 
(e.g. HVAC transformation piece)  

 P-27238 Diagrams 
System now prompts for duct dimensions if default values aren't set for 
HVAC line 

 P-27963 Diagrams 
System no longer hangs performing consistency check on diagram with 
HVAC OPCs 

15734 P-24747 
Sch. Model 
Manager 

A correction has been made to model import to set references and prevent 
Schematic Model Viewer problems 

20872 P-28430 
Sch. Model 
Manager 

The Splash screen has been adjusted to cope better with long product 
version names. 
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Incident 

number 

Defect 

number 

Product Description 

 P-3674 Integrator 
Connection error messages are now captured into a new Integrator 
Messages Dialog at the end of the build 

17862 P-26101 
Integrator Compare report now runs faster and has only the line requested - it includes 

connecting lines if pipe crosses more than one pipeline 

19229 P-27205 
Integrator Now prevent "Internal Integrator" errors on PIPE build with unset GTYPs on 

SCFITTs intended to be tees 

19368 P-27416 
Integrator Error messages are now captured into a new Integrator Messages Dialog at 

the end of the build 

 P-28008 

Integrator <CNTRL>-c on a single line copies that line to the paste buffer;  
a popup menu option "Copy to clipboard" copies the visible text  to the 
paste buffer [for all message records];  
<SHIFT> right-click popup menu "Copy to clipboard" copies the message 
type, the visible text and the long description to the paste buffer in CSV 
format [for all message records] 

20347 

P-27930  
P-28011  
P-28043  
P-28044  
P-28457  
P-28491  
P-28498  

Integrator 

Improvements to remove many causes of “Internal Integrator” errors  

 P-28320 
Integrator A warning is now output for unset spec on choose component, HSTU or 

LSTU in build pipe 

 
P-28427  
P-28541 

Integrator 
Better handling of invalid attributes and UDA definitions. 

 P-28469 
Integrator Workaround to reduce occurrence of “Choice is not available” messages 

when choice is available in spec 

 P-28495 Integrator SCOPCO and SCOPCI no longer have Build option in their context menu 

19376 P-28501 
Integrator Now allows link of NOZZ below SUBE to SCNOZZ below SCEQUI, and 

automatically links owning SUBE when trying to link nozzles 

 P-28593 Integrator Exception no longer thrown when comparing specific LNG line  

 P-28874 Integrator Build HVAC now correctly sets THREEWAY CREF   

12.0.SP5.2: Release No. 51919 

Incident 

number 

Defect 

number 

Product Description 

15015 P-23520 Diagrams Lower and upper case in the STYP field 

 P-24175 
Diagrams Prompt for attributes doesn't display default value for UDAs with Lists of 

Values. 

17781 P-26012 Diagrams Upgrade DB now works correctly 

18905 P-26959 Diagrams Multi-cables now show length if connected equipment is positioned 

 P-27025 Diagrams Branching Bore question is repeated over and over 

 P-27453 Diagrams Save As doesn't work as expected. 

 P-27479 MDS Unable to create an ABA drawing from Deliverable Manager 

 P-27481 MDS Isos now work in Deliverable Manager when MDS is in PMLLIB path 

18189 P-26596 PDMS Quick pipe router now works when Choose Component set to Bends 

16210 P-26816 PDMS Component order was changed by Model editor (ATTA in branch) 

 P-27507 PDMS Design 'Production Check' created incorrect spool 

 P-27579 PDMS Draft doesn’t represent vgaplength correctly 

 P-27594 PDMS Paragon: error setting parameter value "6", "6.0" in. 

14222 P-23037 PDMS AutoDRAFT: Import Cyrillic symbols in Backing Sheets 

 P-23356 PDMS Paragon: Error "(61,620)  F&M: Value is invalid" no longer appears 

18025 P-26333 PDMS Paragon: GPART modification propagation 
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Incident 

number 

Defect 

number 

Product Description 

 P-26884 PDMS Cable Design: fixed Unhandled Error when picking Tail Free Route  

18796 P-26915 PDMS Admin: User’s form caused lock-up (OK in Design) 

19104 P-27126 Global Administering a Satellite from the Hub causes ACA crash on exit 

 P-27200 PDMS Design: Fixed performance when changing colour using Drawlist  

 P-27593 PDMS Paragon: Modify Point grid for SEXT showed vertices of owned NSEX 

 P-27595 PDMS Paragon: can now set DTITLE in Russian for DATA elements 

 P-27596 PDMS Paragon: Component Bolt Reference Array (BLRF) handling improved 

19841 P-27719 PDMS Status Controller could stop PDMS launching due to .NET security 

 P-27809 PDMS Draft: DXF export failed with PDMS multi-byte fonts 

20118 P-27880 PDMS Design (Beams & Columns): Flip command was not working 

 P-27922 PDMS 
Design: Changing SCTN default SPREF with (Create) Section form open stopped 
event-driven picks 

 P-27923 PDMS Design: Section specification form now shows steel spec properties 

 P-28075 PDMS Draft: DXF export of Asian text was incorrect 

12.0.SP5.1: Release No. 51915 

Incident 

number 

Defect 

number 

Product Description 

18491 P-26654 Integrator Unable to link a 2D SCINST to a 3D INST 

 P-26720 Integrator Reselecting equipment spec deletes any linked nozzle below existing template 

 

P-27029  
P-27480  
P-27583  
P-27731 

Integrator 

Resolved a number of issues resulting in Internal Integrator errors  

 P-27407 Integrator Incompatible match warning on matching instrument prevents link 

19375 P-27417 
Integrator Do not force select with single choice if STYP does not match (final choose 

option) 

19961 P-27791 Integrator Diagram Viewer - View logic improvement 

19964 P-27792 Integrator OLET, BOSS could be selected when we build piping 

 P-27868 Integrator Warn if component selection cancelled during build 

 P-28082 Integrator Portions of 3D objects were clipped when rotating 3D compare view 

 P-26777 Sch. M. M text carriage returns fail with non-English settings 

18819 P-26877 Sch. M. M Borearray unset on SCTUB on Import 

 P-27055 Sch. M. M Identities in TEXT elements not correctly processed. 

 P-27056 Sch. M. M aveva.Pdms.Database.Xml doesn't support efficient id navigation 

18912  P-27065 Sch. M. M Confusing error related to CRFA on import 

19532 P-27446 Sch. M. M Saved searches for SCBRANCH and SCPLINE cause crash. 

19534 P-27447 Sch. M. M Populating Search Result dialog with LLTO OR LLFROM  causes crash 

19423 P-27552 Sch. M. M On XML import, "PDMS.TypeFormat" was truncated to 3 letters 

19937 P-27800 Sch. M. M Problem when proj dflts is a search path 

 P-27993 Sch. M. M Attribute Derivation Rules for Name Clashes now work correctly 

 

Other: 
Incident 

number 

Defect 

number 

Product Description 

SI-19153 
SI-18489 
SI-18351 

P-3660 
P-27149 
P-26650 
P-26538 

PDMS 
Various minor changes have been made to the Paragon GUI and the Cats and 
Specs User Guide following the new wall thickness tables introduced in earlier 
service packs. 

SI-18173 
 

P-26438 PDMS The SAM sample project had incorrect Cable-tray Property data for variable 

length straights, leading to incorrect weight & centre-of-gravity. 
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